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Section 1: Safety and Ink Usage
Following is a list of safety symbols and their meanings, which will be found throughout this
manual. Pay attention to these symbols where they appear in the manual.

Wear safety goggles when performing the procedure described!

Caution or Warning! Denotes possible personal injury and/or damage to the equip-
ment.

Caution or Warning! Denotes possible personal injury and/or equipment damage
due to electrical hazard.

NOTE: (Will be followed by a brief comment or explanation.)

Only trained personnel should operate and service the equipment.

NOTE: It is extremely important to:
• Clean up all ink spills with the appropriate conditioners immediately and dispose of all

waste according to local and state regulations.
• Wear safety glasses and protective clothing, including gloves, when handling all inks

and conditioners.
• Store inks and conditioners under the recommended conditions found on the MSDS

(Material Safety Data Sheet).

PRODUCT COMPLIANCE DISCLAIMER NOTE:

This product meets the requirements of UL60950-1:2007/A2:2014, EN60950-1:2006/
A2:2013, CAN/CSA C22.2 No. 60950-1:2007/A2:2014 using FoxJet an ITW Company
approved items. Units are only tested and qualified with FoxJet an ITW Company approved
inks, parts and accessories. Use of other inks, parts or accessories may introduce potential
risks that FoxJet an ITW Company can assume no liability for.

!
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Section 2: Installation 

1 Controller, Matrix or Elite

2 Proseries Print Head

3 Conveyor

4 Product

5 Print System Bracketry

6 Encoder

7 Ink Supply

8 Photo Sensor

9 Vacuum Waste Collector Bottle

10 Encoder Cable

11 Alarm Beacon (Strobe)
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The figure below illustrates a typical conveyor-mounted installation. (Cables are not
shown.)

Materials Required for Installation
You will need the following items:
• Lint-free wipes
• Safety goggles
• Level
• Tape measure

Use appropriate safety equipment and procedures. Leave print heads in their shipping car-
tons until all bracketry is in place and tightened down.
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Step 1: Installing Bracketry
Bracketry is the structure that supports the controller, print system and other accessories.
Carefully plan the mounting location of the equipment. Keep in mind bracketry hardware
location and printer equipment size. Assemble all bracketry to the floor, conveyor, or other
bracketry. 

This manual details instructions for mounting all system components to a conveyor. Other
mounting options for the controller and print system include the floor mount and the retract-
ing bracket (see “Appendix C: Part Numbers” on page 83). Assembly instructions are
included with mount kits.

Corner brackets are attached to aluminum bars as shown.

Retracting Bracket

Floor Mount

Conveyor Mount

Corner Bracket
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Step 2: Mounting the Print System
Unpack the print head just before mounting to the bracketry. 

Attach the print head to the bracketry with a print head mounting bracket. Do not connect to
power outlet.

The print head must be mounted in close proximity to the product. To maintain consistent
print, the head should be mounted no more than 1/8" from the substrate. An optional
retracting bracket is available to mount the head and control the distance from the head to
the substrate. The retracting bracket allows the head to bump the product and retract as
required to maintain a consistent throw distance. (See “System” on page 83 for bracketry
options.)

NOTE: Install optional retracting bracket kit on the print head prior to mounting the print
head to the conveyor bracket.

It may be necessary to vertically adjust each bracket's horizontal bar later to fine-tune mes-
sage placement. This is especially true when using multiple print heads, as message lines
will need to be synchronized with each other.

NOTE: When adjusting the horizontal bar or print head mounting bracket, always support
the print head with your hand to keep it from falling forward onto the conveyor.

NOTE: ProSeries print heads are supplied ink via capillary forces. Print heads must be
mounted in a level position from front to back to prevent leakage and provide proper ink
flow.

INK SYSTEM

WASTE BOTTLE

PRINT HEAD

INK BOTTLE
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Setting Up the Print Head

The Matrix/Classic Series print heads are mounted using the 10-32 tapped holes on the
right or left side of the Ink System bottom case. The print head angle can be set between 0°
and 90°. (See “FJSOP4 - Installation of FoxJet High Resolution AMS/APS Printheads” on
page 97 for additional information.)

To adjust the head to its correct angle:
1. Loosen the two set screws (1/8" hex head) on the print head side of the head mount.
2. Rotate the head to the desired angle.
3. Secure the set screws. 
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Ship Caps

NOTE: If you place the Print Head Ship Cap on a hot print head and do not fasten it
securely, the print head will weep ink until the head has cooled down. 

NOTE: Ink may accumulate behind the ship cap during shipping.

Remove the Vent Ship 
Cap and Install the Fil-
ter. Remove the Res-
ervoir Ship Cap and 
Install the Ink Bottle. 
Remove Waste Reser-
voir Ship Cap and 
install Waste Reser-
voir. Save caps in a 
zip-lock bag for 
future use. 

THUMBSCREWS

SHIP CAP

VENT SHIP CAP

WASTE RESERVOIR
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Inks 

Ink is supplied via 500 mL plastic containers. ScanTrue® II PLUS is a pigmented ink formu-
lated for use on porous substrates.

NOTE: Check the label on the Print Head for correct ink type.

Waste Bottle

The APS includes a Waste Collection Bottle mounted on the rear of the Print Head assem-
bly. This bottle must be changed when full to prevent improper operation of the system.
Instructions for waste disposal are on the collection bottle.

Do not reuse waste ink; contaminants will reduce system lifespan.

Step 3: Mounting the Photosensor and Encoder

Photosensor

The photosensor is both a light source and a sensor. It emits light and detects the arrival of
a product when the product reflects the light source back to the sensor. The sensor then
sends a signal to the controller to start the printing cycle.

The product detect Photosensor should be mounted on either side of the print head so that
the product passes by the sensor before the print face. Remove the plugs or set screws (3/
32" hex head) in the photosensor mounting holes, then attach the Photosensor Mounting
Bracket with the 10-32 x 1/2" screws provided with the bracket.

Encoder

The encoder assembly provides conveyor line
speed information to the controller. It also allows
automatic disabling of printing when the line
stops.

The Marksman© Matrix & Elite System uses a
5000 ppr open collector output encoder. The
wheel is sized to provide the correct timing
inputs to allow the print heads to print from 150
to 300 dpi.

ENCODER ASSEMBLY
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The encoder uses a wheel
that rolls against the con-
veyor line to track its speed. It
sends a signal to the control-
ler, which adjusts for changes
in line speed.

It is not necessary to install
the encoder immediately adja-
cent to the print heads. It is
more important to place it
where it will accurately mea-
sure the speed of the con-
veyor. Install it in contact with
the conveyor, or with a wheel
or roller moving the same
speed as the conveyor. 

The encoder's mounting
bracket is spring-loaded.
Adjust the spring collar to
ensure that the encoder main-
tains stable contact with the
conveyor.

CAUTION:   Do not jam the encoder wheel against the surface of the conveyor. A radial
force of over 40 lbs. will reduce the life of the bearings. 

Spring

Mounting
Bracket

Encoder
 Wheel

Conveyor

Out to Controller

Mounting Bracket
Shaft

Encoder

ENCODER
ASSEMBLY

!
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Step 4: Electrical Cable Connections 

PRINT
SYSTEM

PRINT HEAD CABLE

PHOTO
SENSOR

ENCODER

SYSTEM
PRINT

ALARM
BEACON
(STROBE)

MARKSMAN MATRIX OR ELITE CONTROLLER

24V
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Views 

VGA

L
IN

E
 O

U
T

HDMI

USB

E
T

H
E

R
N

E
T

12 VDC
COM 1

STROBECOM 2 ENCODER

1

2

OUTPUT TO
PRINTHEAD

4

3

P
R

IN
T

 H
E

A
D

 C
A

R
D

S

Bottom view of Matrix Controller
(With Optional second PHC Board

Back view of
Print System

Bottom view of 
Elite Controller

HEAD 3 & 4

CONNECTIONS

I/O PORT

SYSTEM
CONNECTIONS

POWER
CORD

ENCODERHEAD 1 & 2

CONNECTIONS
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Step 5: Priming the Print Heads

Priming:
1. With the Print Face Cover installed, press and hold

the Prime Button for ~10 seconds (until Ink Supply
LED blinks slowly) to activate the recirculation
function. Allow the system to recirculate for at least
5 minutes before pressing the Prime Button again
to end the cycle.

2. Remove the Print Face Cover and store in a con-
venient nearby location.

3. Use a foam swab to lightly wipe the orifice plate in
a vertical downward motion.

4. Prime the print head by momen-
tarily pressing the Prime Button
to manually activate the APS
(Automatic Priming System)
Cycle. Observe the print face for
bubbles in the ink. In the case of
visible bubbles, activate the
APS cycle 2-3 more times or
until no air is observed.

5. Verify print quality by using the
Marksman Controller to print a
Test Pattern (accessed via.
“Configure” menu) while slowly
passing a sheet of paper in front
of the print face. Ensure that no
gaps are present in the print and
that it has printed the full avail-
able height (2” for 384 and 4” for
768).

6. If gaps are present in the print sample, follow the recommended procedure for Recircu-
lation as necessary until the print head passes the print quality test above.

7. With all channels firing, the print head is ready to begin printing.

Recirculation

This function circulates ink through the print head to draw air out of the system. It is very
effective in recovering print channels.

1. If not installed; reinstall the Print Face Cover. Ensure that ship cap is clean before rein-
stalling by wiping the gasket with a lint-free wipe or a foam swab.

2. Press and hold the Prime Button until the Ink Supply LED blinks slowly (~10 seconds)
to activate the recirculation function. For the first 5 seconds the print head will run
through the Manual Prime cycle, continue holding the button to activate the Recircula-
tion mode. The Ink Supply LED will blink slowly while recirculation is active. Do not
remove the Print Face Cover in this mode.

3. Allow the recirculation function to run for the desired length of time. Five minutes is the
recommended interval.

4. Press the Prime Button to end the recirculation function. If the button is not pressed,
recirculation will shut off automatically after 15 minutes.

PRINT FACE COVER
CORRECT ORIENTATION

RESERVOIR
SHIP CAP

PRIME BUTTON

VENT FILTER

VENT SHIP CAP

INK
BOTTLE

WASTE INK SHIP CAP



 Section 2: InstallationMarksman Matrix & Elite

2465-623 User Manual Rev F Page 13

APS Cycle

The APS Cycle is a means of maintaining print quality. The APS system does this by using
a priming pump to force ink out of the channels and a vacuum pump and Waste Bottle to
collect the ink waste. The APS Cycle can be manually started by momentarily pressing the
prime button.

The APS Cycle will automatically activate at a designated time interval, which can be
adjusted using the rotary switch on the side of the Ink System case near the Prime Button.
The table below defines the settings available. Setting the rotary switch to 0 will disable
both automatic and manual APS cycles. 

Manual Prime

A manual prime cycle is similar
to an APS cycle, except that it
is a bit more powerful and
uses a bit more ink. The cycle
can be started by pressing and
holding the Prime Button on
the rear of the print head hous-
ing for longer than 1 second.
The cycle will run while the
Prime Button is held, up to 5
seconds total. Make sure to
release the button before 10
seconds have passed, to avoid
entering the Recirculation
mode without the Print Face
Cover attached.

NOTE: The system will not prime either manually or automatically if there is a low ink indi-
cation, which is caused by either low ink in the reservoir or full ink in the waste collection
bottle.

NOTE: Adjustment of Print Head angle should be done according to the procedure outlined
in “Setting Up the Print Head” on page 6.

No APS UJ II Print Heads ProSeries 384/768 (e)

Switch Setting 0 1 2 3 4 5 6 7 8 9 A B C D E F

Interval (hours) 0 2 4 6 8 10 12 14 16 18 1 2 4 6 8 12

REMOVE PLUG 
TO ACCESS

LED

SELECTION 
INDICATOR

ROTARY SWITCH 
DETAIL
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Auxiliary Photosensor Input

NOTE: The APS Control Cable and Auxiliary Photosensor cannot be used together.

An Auxiliary Photosensor input is available to insure a print cycle is not missed during the
automatic priming sequence. Connecting the Auxiliary Photosensor will delay a prime
sequence until there is enough time to complete the sequence without missing a print
cycle. The default delay setting is three (3) seconds after the product passes the photosen-
sor.  Multiple heads can share the Auxiliary Photosensor by using the Photosensor "Y"
Cable. To change the default setting, perform the following steps:
1. Ensure that the rotary switch is not in the "0" position.
2. Place a box in front of the photosensor.
3. While the photosensor is on, set the rotary switch to 0.
4. When the LED stays illuminated continuously, set the rotary switch to a new number (1

through F) representing the number of seconds (1 through 15) you want to delay. Note:
"0" is not an available user setting.

5. Press and hold the Prime button until the LED starts flashing.
6. Release the Prime button.
7. Remove the box from in front of the photosensor.
8. Set the rotary switch back to the desired hour setting.



 Section 5: Getting StartedMarksman Matrix & Elite

2465-623 User Manual Rev F Page 15

Section 5: Getting Started
The Marksman Matrix and Elite controllers are standalone units capable of operat-
ing up to four print heads, with the addition of an optional controller card. The soft-
ware has an ICON user interface. The main difference between the two controllers
is the size and the resolution of the displays. The resolutions are 1024 x 1280 for
the Elite and 1024 x 600 for the Matrix. The extra room on the Elite display allows
for the software keyboard to be accessible at all times. To access the keyboard on
the Matrix, simply select a field that requires keyboard input and it will appear. 

To Windows Special Function

Change keyboard 
language.

Matrix Keyboard
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Login

Select the Login ICON. The following screen will appear for the Matrix. Enter a username 
then tab to the next field, enter a password then select the Enter button or the green check 
mark. Once logged in the users account will display on the lock.

Note: User names and passwords are not case sensitive.

Logout

Each user should log out of the Marksman© Elite application after use to enforce the secu-
rity restrictions. The user may log out by selecting the closed padlock icon from the main
display. The system will continue operating in its current state. All menu options are dis-
abled after the user logs out, with the exception of the Login, Preview options and Info.

Before Login, Matrix

Before Login, Elite

Default Username and Password:
Username: Admin
Password: FOXJET
(not case sensitive)
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Start Message:
The start message is used to ready 
the system to print a label or image 
that was created with the BoxWriter 
Editor.

Select the desired message from the 
list, or enter the message name, and 
press the OK button.

Select the "Reset counts to zero"
radio button to reset counts at the
start of the message; unselect it to
allow the count value to accumulate.

Stop Message
Stopping a message halts all printing related to the selected production line. The product 
count is reset to zero.

The Stop message icon may be selected from the tool bar to stop the task on the selected
production line.

Idle Message
The Idle message option causes the printing to pause on the selected production line. The
product counts are halted until the current message is Resumed

Resume Message
The Resume message option causes the printing to resume on the selected production
line. The product counts are restored from the previously idled message.

Exit

This will close down the all printing operation and exit out of BoxWriter software. Only oper-
ators with proper security rights can Exit the software.

Start
message

Pause or
Resume

message
Count 

Stop Mes-
sage

Variable 
data

Exit

Editor
Configure

Reports

Info / 
Preview

Photocell 
Delay

Login / 
Logout

Preview
Window

Zoom to fit

Zoom in

Zoom out
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Counts
Count is the current number
of the box in the pallet series.
It is always listed as the "last
printed" box. To change the
Count value, enter the current
box count value. Enter a 0 to
print a count of 1 on the next
box.

User Data
User data or User elements
may only be changed if the
message is loaded. The mes-
sage must contain user ele-
ments and be "Running" or
"Idle" in order to modify the

user data. 

Select the User data ICON.
Edit the data in the lower edit
box and press OK to save
changes. For multiple ele-
ments, make all data changes
before pressing OK to save
changes. Press Cancel to exit
without saving changes.
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Info Window / Preview Window
Select the icon to toggle between Info and Preview:

NOTE: The system will not print if the controller is reporting a Low Voltage Error, Out of Ink
condition or Low Temperature condition. If a strobe is connected to the system, this is rep-
resented by a flashing red light.

Select the icon to toggle between Info and Preview:

Print Head Ink level or 
Ink Collection bottle

Green = Good
Yellow = Low

Red = Out

Print Head High Voltage
Green = Good

Red = Low

Print Head Temperature 
Green = Good

Red = Low

Current Message

Count:

Next count to be printed

Production Line

Print Head Status:

Green: OK

Yellow: Low Ink

Red: System Printing Error Message State:

Printing Stopped
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Configure:
The Configure icon allows access to other options: Print Test
Pattern, Database Start, Print Heads, Production Line, System,
Security, Import, Export, and Help.

Configure, Print Test Pattern
This function is designed to exercise every channel of the print 
head to verify all are printing properly.

When the user clicks the “Test Pattern” button, a test image is
generated. Each head on the currently selected line will print
this pattern (along with the print head’s name). In the example
below, the Test Pattern is from Head 1.

Configure, Database Start

Set a message based on data that is located in a database. The database must be setup
before the option is available. Refer to “Appendix D: Database Start” on page 86.

Configure, Print Heads

Select Configure, then select Print Heads from the menu. Select a panel and click on a
head. A head may be added or deleted. To edit a head, select it and click Edit; or double
click it.

Name: The head’s user-defined name.

Panel: The panel which the head will print on.

Print Resolution: 150, 200 and 300 dots per inch (dpi).
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Type: Select a head type from the drop-down menu list.

Address: Each card is assigned two heads: 1a and 1b, or 2a and 2b. The cards have jump-
ers to determine which card it is. The bottom connector of the card is always the desig-
nated as “a”.

Photo delay: Photo delay is the horizontal distance (in inches) measured from the photo-
cell to the head.

Auto print inches: If internal photosensor source is selected, this number indicates the dis-
tance from start to start of a repeating print. For example, if it is set to 36, the internal pho-
tosensor will fire once for every 36 inches of travel of the conveyor, as indicated by the 
encoder. An external photosensor must be connected and tripped for this to work. 

Height on box: The vertical distance in inches measured from the bottom of the product or 
conveyor to the bottom of print.

Encoder Speed: The desired internal encoder speed measured in feet per minute. The 
default is 60 feet/min

Photosensor source:  Indicates whether the photosensor is external or internal. The photo-
sensor signal from another head may also be used (shared).

Encoder source: Indicates whether the encoder is external or internal. The encoder signal 
from another head may also be used (shared). 

Direction: The direction of travel of the product may be right-to-left or left-to-right, as viewed 
from behind the print head. 

Master:  Each line must have a master head. The master print head receives/distributes 
the signals for the photosensor and encoder to the remaining heads. The master head is 
also used to determine count values.

Double pulse: Creates a darker print generally needed for the ProSeries 768e and 384e.

Enable: Activates the print control card and ability to monitor errors.

Upside Down: Used to print the entire message upside down. 

More - Linked to: Ties the information to be printed to additional heads. If the information is 
the same on multiple sides of the box, link the heads together and the image is 
automatically placed on the other head. 



 Section 5: Getting StartedMarksman Matrix & Elite

2465-623 User Manual Rev F Page 22

Configure, Production Line
The production line configuration allows for 
grouping of settings that relate to a 
particular setup. Select Configure, then 
Production Line form the menu. To edit a 
line, select it and click Edit; or double click 
the line.

Add: The Add button allows for the addi-
tion of another production line, for a maxi-
mum of two production lines.

Delete: The Delete button allows for the 
removal of a production line form the configuration. All messages created for the produc-
tion line will be deleted.

Description: The description field is used to help define the production line.

Coupled: If this field is checked, starting a message on one line will also start in on the 
other. The same is true for Stop, Idle and Resume. Note that you must have a two lines 
configured to use this feature.

Fixed Scanner

This group defines the parameters for a 
fixed scanner that may be connected to 
the Controller, The data is stored under 
the Scan Report (see “Reports” on 
page 28).

No Read String: The No Read String must
match the No Read string that is transmit-
ted by a fixed scanner. The printing will be
stopped upon reaching the maximum
value.

Consecutive No Reads: The consecutive 
No Reads field is used to preform a quality check on barcodes that are printed, This value 
determines the maximum number of consecutive No Reads that may be transmitted by a 
fixed scanner. The printing will be stropped upon reaching the maximum value.

Serial Download Port: Please select the port to be used to send the data out if it is required 
to be transmitted to a device at the start of each task. The data is entered through the 
Editor Task properties.

Reset on Task Start: The Reset on Task start check box determines that the current num-
ber of consecutive No Reads will be reset to zero upon a message start.

Buffer Offset: The Buffer Offset value determines the number of characters to offset into 
the buffer as transmitted by the hand scanner.

Data Length: The Data Length value determines the number of characters to extract from
the data buffer that will form a task name.



 Section 5: Getting StartedMarksman Matrix & Elite

2465-623 User Manual Rev F Page 23

Configure, System

General Setting– Windows Ports

Used to configure the system 
COM ports, that may be used for 
variable data or stating a mes-

sage. 

Serial Port: Select the 
appropriate button to edit the 
setup parameters for a serial port 
on the Matrix or Elite. 

Each of the properties may be 
selected using the corresponding 
drop-down menu choices. When 
selections are complete, click 
Apply. The default selections are 
shown in the screen at the right.

Baud: 9600, 19200, 38400, 
57600 or 115200.

Parity: None, Odd, or Even.

Data Bits: Data Bits determines 
the number of data bits used. It 
may be set to 7 or 8.

Stop Bits: Stop Bits determines 
the number of stop bits to be 
used. It may be set to 1, 1.5 or 2.

Device Type:

Task Start- Serial device used to select/start a message, generally a hand scanner.

Database task start– Serial device used to search database for message start.

Barcode Verification– Fixed scanner used to read each barcode after it is printed.

Variable Data– Data to be printed imported through the serial port.

Host interface– Remote control of the Controller through the serial port.

General Setting - Startup

To restart the message that was running if
power is lost or the system was shut down,
check the "Automatically restart last task"
box. (This box is checked by default).
Remember user data: The data will be
retained until new data is entered, even if
the software is reset.
Remember serial data: The data will be
retained until new data is sent, even if the
software is reset.
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General Setting - Counts

Continuous Count: Select this feature to
cause the Count on the main screen to
never reset to zero at the start of a new
message.

General Setting - Time:

The main screen Time and Date field format 
is defined in this window. There are three 
user controlled date and time fields that can 
be formatted.

Suppress time change warnings: 
Used to disable software warnings of any 
Windows time changes. 

Current time: Windows system time.

General Setting - Ink Codes 

(This screen is for future enhancement.)
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Configure, Security:

Users: 

The security feature of the Marks-
man Matrix & Elite Series allows the
system administrator to configure
users and access rights.

Add: Select the Add button to 
create a user account.

Remove: Select the Remove button 
to delete a user account.

Properties: Select the Properties 
button to modify or view the user 
account information.

Firstname: Enter the user’s first 
name in this edit box.

Lastname: Enter the user’s last 
name in this edit box.

Username: Enter the user’s first 
name in this edit box.
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Group Options:

Security groups allow the administrator to assign similar users with a specific set of access
rights. Select Security, then Group Options from the menu. Ten configurable security
groups are available. A user must be assigned to one group. Group names may be modi-
fied to better describe the access level. Select a Group, then select or unselect Options.
Click OK to accept changes and close the screen.

The default access rights for each security group are shown in the following table:

Security Group/Option Access 
Table 

 O
perator 

 M
an

ager 

 L
evel 3 

  G
raphics D

ept. 

  Supervisor 

 L
evel 6 

 L
evel 7 

 L
evel 8 

 L
evel 9 

 A
dm

inistrator 

Output Table    X 

Configure Print Head Settings   X    X   X    X    X 

Start Message   X    X    X 

Stop Message   X    X   X   X    X 

Place System in Test Mode    X 

Run Editor    X 

Configure Production Lines   X   X    X    X 

Configure Users    X 

Configure Security Options    X 

View/Clear Scanner Report    X 

View/Clear Scanner Report    X 

Translate the software    X 

Configure general Windows    X 

Exit Application    X 

Configure task start database    X 

Configure serial data format    X 

Configure the strobe    X 

Import    X 

Export    X 
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Configure, Import:
NOTE: It is recommended that all printing tasks be stopped until the Import function has
been successfully completed; and that the current database be exported for backup pur-
poses.

To import all tasks that were previ-
ously exported, choose File, then
Import.

In the “filename” field, input the
name of the file (full path) the
exported tasks were saved to; or
browse for the file by clicking the
Browse button.
If there is data on the controller that
the user wants to back-up, click Yes
on the Export option.

Configure, Export:
NOTE: It is recommended that all printing tasks be stopped until the Export function has 
been successfully completed.

To export all existing tasks, choose 
File, then Export.

Input the name of the file to export 
to, or browse for an existing file by 
clicking the Browse button. Click 
the Export button. If the file already 
exists, the user will be prompted to 
overwrite the file or cancel the 
request.

If successful, a confirmation mes-
sage will appear.

Configure, Help:

About

Components: A list of the .dll that are installed and the version number. 

Cmd line args: A list of the software options that are turned on.

Firmware: A list of the Gate Array version number of the Print Head controller cards. 

Translate

Select the desired language to be converted to. When the files have been translated, the
application will be re-started in the desired language.
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Reports

Scan reports
The Scan Report contains information relating to the current task and scan results of a
printed barcode. The scan results are received through the RS232 port from a barcode
scanner properly. configured and connected to the Marksman© controller.

Date: Date is the date the scan event occurred.

Line: Line is the production line that the scan event occurred on.

Message: Message is the name of the message operating while the scan event occurred.

Barcode: Barcode is the barcode data scanned and received. The contents of this field 
may contain the words NO READ if the barcode could not be decoded.

Total: Total number of decode attempts, including successful and failed decodes.

Good: Good indicates the number of successful decodes of the scanned barcode.

Export: Export allows the information to be saved in a comma delimiter format so it can be 
used in other software applications.

Enabled: Allows for the collection of data.

Auto Export at Task Start: Exports an entry to text file defined by export path.

Print reports

The Print Report contains historical information regarding the printing operation. The print
report is a table named reports within a Microsoft® Access® Database named Marksman
Elite. Click on Reports then select Printer Report from the menu.

Time: Date and time that the 

action occurred.

Action: The event such as 
Start or Stop Message.

User: The User who was 
logged in at the time the 
action occurred.

Counts: Counts is the product
count of the task for which the
action applies.

Line: The production line that 
the information is for.

Message: The name of the 
message for which the action applies.

Export: Export allows the information to be saved in a comma delimiter format so it can be 
used in other software applications.

Auto Export at Task Start: Exports an entry to text file defined by export path.

Enabled: Allows for the collection of data.
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Delays
This feature allows the opera-
tor to make changes to where
the print starts, or change the
photosensor delay.   These
changes are not permanent
and only last until another
message is selected. This
may be useful do to variations
in the location of pre-printed
information on the box.

NOTE: Changes made using the Delay ICON are only temporary or until another message
is started. Permanent changes to the photosensor delays must be done through the Con-
figuration.

To make changes, Select the 
desired head, use the arrow 
buttons to decrease or 

increase the delay value. 

Use the Apply button to 
implement the changes.
The incremental value can be 
changed by selecting the field.

Select OK when complete.

To Decrease
delay

To Increase 
Delay

Incremental Value



 Section 6: BoxWriter© Matrix & Elite EditorMarksman Matrix & Elite

2465-623 User Manual Rev F Page 30

Section 6: BoxWriter© Matrix & Elite Editor

Select the Editor icon to launch the Marksman BoxWriter Editor application. The user must
have the required rights to use this feature.

Define

Boxes

To define boxes, select Define > Boxes
from the top of the Editor screen.

To add a new box, click Add. Enter the
length, width, height and name. The
length, width and height fields must be
between 1 and 40 inches. The description
field is optional.

To edit an existing box, select it and click
Edit, or double-click the item.
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To delete an existing box, select it
and click Delete. Multiple boxes can
be selected by using the shift and/or
control keys. Boxes that are cur-
rently in use in a task cannot be
deleted. The task’s box property
must be changed before the box can
be deleted here.

Pre-printed information can be
added to the box to give the opera-
tor a true representation of how the
box will look as it is being printed on.

Add: Allows the operator to assign a
.bmp or .jpg file to a panel on the
box.

Edit: Allows the operator to change
which .bmp or .jpg file is assigned to
a panel of the box.

Delete: Will remove the file from the
panel.

 

Box Usage

To define box usage, select
Define > Box usage.

If it is desirable to restrict a
box from a given line, it can
be done here. By default, all
new boxes are available on
all lines. To restrict it, select
the line, then select the box.
It can then be moved to the
"restricted" list by clicking
the "<" key. Clicking the
"<<" moves all boxes for a
given line to the restricted
list, regardless of selection.
Conversely, the ">" and
">>" keys move boxes to
the "available" list.
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Editor Defaults

To define editor defaults, select Define > Editor
defaults.

This dialog controls the editor's display units. 

The "Resize handle size" field is used by re-siz-
able elements (such as a Bitmap element). Valid
values range from 5 to 15. Larger values make it
easier to perform a resize operation on a touch
screen. 

In the example at right, the eight squares
around the perimeter are the resize handles.

Checking the "Warn if elements overlap" box will warn
the user when element fields overlap in a message. 

Element Defaults

To define element defaults, select
Define > Element defaults. To
change the defaults, select an ele-
ment type and click Properties, or
double-click the item.

The elements listed here define
how new elements are created.
(For a description of the individual
elements, refer to the Elements
section of this manual.)
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To change the font, click
the Change button. The
dialog at right is used to
change the default font
parameters.

The Font drop-down box
will display a list of all
TrueType fonts installed
on the system. 

The Size field refers to
the height of the font in
pixels. 

Average width defines
the average character
width (in pixels). A value
of 0 means that the sys-
tem will use the font's
default widths.

Backup Path

A backup of the Marksman Matrix & Elite database is stored in a backup location every
time the application is closed. The path directs where the file is saved.

Custom Date/Time Formats

To define date/time set-
tings, select Define > Cus-
tom date/time formats.

The date/time settings
shown here are used by
Date/time and Expiration
date elements.

To create a new custom
format, click Add.

To delete an existing cus-
tom format, select it and
click Delete. Multiple codes
can be selected by using
the shift and/or control
keys.
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To edit an existing custom code, select it and click Edit, or double-click it. The Build date/
time format dialog is shown below.

Format string: Contains a user-defined string consisting of format specifiers.

Sample: Shows a sample of the current Format string.

Valid format specifiers are listed at the bottom of the dialog. To insert them in the current
string, select them and click Insert (or double-click).
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Date/Time Codes

Select Configure, System, then Date/Time Codes from the menu.

Line: Line indicates the production
line selected. 

Click on the folder tabs to access
the date/time code tables. Select an
entry in the table by clicking on the
desired row. Click on Edit to modify
the data for the selected table entry. 

Click OK to exit and save changes
or Cancel to exit without saving
changes.

Months: Months represents the
string values that are used in date
codes for the standard months of
the year.

Hours: The Hours table stores the
twenty-four codes for the hours of
the day. The codes may be custom-
ized for special coding.

Quarter Hours: The Quarter Hours’ table stores codes for 15 minute intervals.

Days: The day table holds the value to be used for the appropriate day.

Rollover: The time at which the
expiration and date codes will
change to a new value. The default
rollover value is midnight.

"Hold": Holds the Date or Expira-
tion Date until the Roll over time.
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Bitmap Settings

To define bitmap set-
tings, select Define >
Bitmap settings.

The "Bitmap editor"
field defines the pro-
gram used to edit bit-
maps. By default, it is
Microsoft® Paint. To
change it, browse
and select the pro-
gram to be used.

Label Editor

Used to configure software when the Marksman Matrix or Elite is used with a Label Appli-
cator.

Shift Codes

To define shift codes, select
Define > Shift codes. Shift
codes are used by Shift ele-
ments.

The shift code’s length must be
from 1 to 15 characters. The
code’s times must be in order
from least to greatest (i.e., code
1 cannot be later than code 2 or
3).

Line: This determines the pro-
duction line for the shift code
definitions.

Select the appropriate production line. Enter the shift start times and any user-defined
codes. The shift start times must be entered in 24-hour format. The shift code may contain
a maximum of 15 alphanumeric characters.

The sample dialog shows shift 1 starting at 7:00 AM, shift 2 starting at 3:00 PM and shift 3
starting at 11:00 PM.
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Sub-Elements

To define fonts, select Define > Sub-elements.

Sub-elements can be used by certain barcodes (see “Global Barcode Parameters” on
page 40 for usage). The Sub-elements dialog is shown below. 

To create a new sub-element, click the "+" button.

To delete an existing sub-element, select it and click the "X" button.

To edit an existing sub-element, select it and click the Properties button (the bottom, left-
most button). The Sub-element properties dialog is shown below. 

ID: Identifies the sub-element. 
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The "Element type" field defines the type of element. The following types are supported by
sub-elements:
• Text
• Count
• Date / time
• Expiration date
• Shift
• User
• Serial data

To change the element's default values, click the Properties button. See “Elements” on
page 50 for examples of property dialogs for element types.

Description: Used for a long-hand description of the sub-element.

Data: Contains the default data for the sub-element. Note that the Data must satisfy the
Input mask.

The Input mask defines what kind of
data the sub-element can accept.
To change it, click the Build button.
The Build mask dialog is shown at
right.

In this example, the mask is set up
for data consisting of two digits and
up to 10 alpha-numeric characters.

The buttons along the right side of the dialog are as follows, from top to bottom:
• Move up - moves the selected mask up.
• Move down - moves the selected mask down.
• Properties - displays the mask properties for editing.
• Add - creates a new mask.
• Delete - deletes the selected mask.
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The following is an example of the Mask
properties dialog: 

• Alpha allows uppercase A to Z.
• Numeric allows 0 to 9.
• Alphanumeric allows uppercase A to Z

or 0 to 9.
• Punctuation allows characters such as

"," or ":".
• Any allows any character.

Application Identifiers

To define fonts,
select Define >
Application
identifiers.

Application 
identifiers can 
also be used by 
certain bar-
codes. They 
work in the 
same manner 
as sub-ele-
ments. 

An example of the 
Application identi-
fier properties dia-
log is shown at right. 

Only the "Element 
type" and "Data" 
fields can be 
changed.   See 
“Sub-Elements” on 
page 37 for descrip-
tions of these fields.
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Global Barcode Parameters

To define barcode parameters, select
Define > Global Barcode Parameters.

Select the line, then select the head
type. Heads with 32 channels have their
own set of barcode parameters, as do
256 channel heads.

To view or edit a set of barcode parame-
ters, select it then click Edit, or double-
click the item.

NOTES: 

Only the custom bar and space parame-
ters can be changed; and only a person
having advanced knowledge of barcode
and inkjet printing systems should
change these parameters. An unusable
barcode may be printed using improper
settings.

C128, C39, C93 & I 2of5: On standard
barcode parameters, the Magnification,
Width, Total height and Ratio cannot be
changed. Only custom parameters allow
these fields to be changed.

UPC: On standard barcode parameters, the Magnification, Bar width and Space width can-
not be changed. Only custom parameters allow these fields to be changed.
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An example of UPCA barcode parame-
ters is shown at right.

Magnification: The value displayed in the
Magnification field on the Barcode ele-
ment dialog.

Bar height: The total height of the symbol
in pixels.

Bar width and Space width: Define the
width, in pixels, of the symbol's bar/space
modules. 

Font name: Displays a list of all TrueType
fonts installed on the system. 

Font size: The height of the font in pixels. 

Avg font width: Defines the aver-
age character width (in pixels). A
value of 0 means that Windows
will use the font's default widths. 

Magnification: The value dis-
played in the Magnification field
on the Barcode element dialog.

Total height: The total height of
the symbol in pixels.

Horz. bearer: Specifies the width
of the symbol's horizontal bearer,
in thousandths of an inch.

Vert bearer: Specifies the width
of the symbol's vertical bearer, in
thousandths of an inch.

Quite zone: Specifies the width of
the symbol's quiet zone, in thou-
sandths of an inch.

Font Name: Displays a list of all TrueType fonts installed on the system. 

Font Size: Refers to the height of the font in pixels.
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Tools

Ink Usage

Select Tools - Ink usage
from the top of the Editor
screen. The ink usage gen-
erator will calculate the cost
of each print and how many
prints you will get from each
bottle.

Files

New

To create a new task,
choose File > New.

The user will be presented
with the dialog at right. Pick
which production line the
task is to be created for, give
it a name (and description, if
desired) and select the box it
will be printed on.

The "Task name" field must
contain only letters and num-
bers; no spaces or special
characters are allowed. The
maximum number of charac-
ters is 32.
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Creating a Task

The next step is to insert elements into the label to be printed. The box is shown with high-
lighted areas showing where heads have been placed on the box. The printing areas can-
not be changed from the editor because the information about the heads and their
relationship to the box comes from the system configuration, which is limited by physical
devices installed.   Different panels can be selected to add elements to the task. Once a
head has been chosen, select an element to be placed on the box. The process is
repeated until all the desired information needed on all sides of the box are completed. The
next step would be to save the task. (Refer to appropriate sections in this manual relating
to “Elements” on page 50 and “Save As” on page 48.)

NOTE: If two elements overlap each other they both will show up in red. This is to let the
operator know that a problem may occur. The operator will also be told before saving the
task.

To disable the element overlap warnings, see “Editor Defaults” on page 32.
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Open

To open an existing task, choose
File > Open.

Select the task to be opened, and
click OK; or double-click the task to
be opened.

Checking the "Open read only" box
will open the task in read-only mode
(i.e., the user will not be able to mod-
ify the task). 

Checking the "Show preview" box
will show a preview of the selected
task. For large tasks, it may take
several seconds to generate the pre-
view.

Copy

To copy tasks from one line to
another, choose File > Copy. 

Select the line to copy from, then
select the tasks to be copied.
Checking the "All" box will auto-
matically select all existing tasks
for the given line.

When the desired tasks are
selected, click Copy. 

If successful, you will see a confir-
mation message.

The user may change both the
"To" and "From" lines and perform the copy function multiple times. 

Click OK after to save the changes.
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This function works best when both the "To" and "From" lines have identical head configu-
rations. However, if they do not, the user may elect to configure the head mapping. To do
this, select the head to be mapped and click Edit (or double-click). 

The user will be presented with
the dialog at right. Select the head
to map to in the "To" field and click
OK. 

Clicking Properties will
bring up the Head proper-
ties dialog. Note that head
properties are read-only in
the Editor.
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Import

NOTE: It is recommended that all printing tasks be stopped until the Import function has
been successfully completed; and that the current database be exported for backup pur-
poses.

To import all tasks that were pre-
viously exported, choose File,
then Import.

In the "filename" field, input the
name of the file (full path) the
exported tasks were saved to; or
browse for the file by clicking the
Browse button. 

If there is data on the controller that the user does not want to lose, click Yes on the follow-
ing screen. 

The screen at right will appear at the
completion of the Import function.
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Export

NOTE: It is recommended that all printing tasks be stopped until the Export function has
been successfully completed.

To export all existing tasks,
choose File, then Export.

Input the name of the file to
export to, or browse for an exist-
ing file by clicking the Browse
button. Click the Export button.
If the file already exists, the user
will be prompted to overwrite the
file or cancel the request.

If successful, a confirmation message will appear.

Delete

To delete existing tasks,
choose File > Delete.

Select the task to be
deleted. Multiple tasks may
be selected by using the
control and/or shift keys.
When the selection has
been made, click Delete. 

The delete function may be
used several times without
closing the window.   Tasks
on other lines may also be
deleted.

Click OK to save the
changes.

Checking the "Show pre-
view" box will show a pre-
view of the selected task.
For large tasks, it may take
several seconds to gener-
ate the preview.
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Save As

To save an open task under a
different name, choose File >
Save as.

The "File" field must contain
only letters and numbers; no
spaces or special characters
are allowed. The maximum
number of characters is 32.

If the name entered
matches a task already in
the database, the user will
be prompted with a confir-
mation dialog, like the one
at right.

Properties

To change an open task's properties, choose File > Properties. The task's description,
download string, box and/or expiration data may be changed using this dialog. 
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The following table lists special ASCII characters that can be entered in the "Download
String" field. (For example, to send 0012345 terminated by a carriage return, enter
"0012345<CR>" in the Download String.) 

Exit

To exit the Editor, choose File > Exit.

Character Description
<NULL> Null
<SOH> Start of heading
<STX> Start of text
<ETX> End of text
<EOT> End of transmission
<ENQ> Enquiry
<ACK> Acknowledge
<BEL> Bell
<BS> Backspace
<HT> Horizontal tab
<LF> NL Line feed, New line
<VT> Vertical tab
<FF> NP Form feed, New page
<CR> Carriage return
<SO> Shift out
<SI> Shift in

<SLE>
<DC1> Device control 1
<DC2> Device control 2
<DC3> Device control 3
<DC4> Device control 4
<NAK> Negative acknowledge
<SYN> Synchronous idle
<ETB> End of transmission block
<CAN> Cancel
<EM> End of medium
<SIB> Substitute
<ESC> Escape
<FS> File separator
<GS> Group separator
<RS> Record separator
<US> Unit separator
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Elements

Element Bar

Using the element bar, the user can add new elements to a task. Element types, from left to
right, are as follows:

• Text
• Bitmap
• Count
• Date / time
• Expiration date
• User Prompted
• Shift Code
• Barcode
• Database
• Serial
• Shape

New elements can be created by clicking one of the buttons on the element bar, by right-
clicking on the printable area of the box, or by using the Elements > Add menu.

When creating a new element, its x, y position (top-left corner) is set to the current location
of the crosshairs.

To edit an existing element's properties, select the element by clicking it, then choose Ele-
ments > Edit from the menu (or press Enter); or double-click an element to edit its proper-
ties. Only one element at a time can be selected to edit.
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Text

The Text element properties are shown
on the right. Text can be entered into
the field either a single line at a time or
multiple lines, paragraph mode. To get
to the next line, simply press Control
and Enter at the same time. This will
advance the cursor to the next line
where text can also be entered. 

Average width defines the average
character width (in pixels). A value of 0
means that Windows will use the font's
default widths.

The Text field displays the data to be
printed. This field can contain between
1 and 255 characters. 

The Orientation field determines if the
data is printed horizontally or vertically.

Link to: Allows the user to tie a text element to a barcode element. When the barcode data
is changed, the text field will automatically change.

 

Figure 1: Horizontal orientation

 

Figure 2: Vertical orientation
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To insert special characters, click the Special button. This will open the Windows Character
Map utility, which can be used to copy and paste special characters. 

Bitmap

The Bitmap element properties dialog is
shown at right. 

The Filename field displays the full path
and filename of the selected bitmap. To
select a different bitmap, click the
Browse button. 

To edit the selected bitmap using the
default bitmap editor, click Edit. Note
that the BoxWriter© Editor will be dis-
abled until the bitmap editor is closed.
To change the default bitmap editor, see
“Bitmap Settings” on page 36 of this
manual.

The Width and Height fields display the
size of the bitmap.



 Section 6: BoxWriter© Matrix & Elite EditorMarksman Matrix & Elite

2465-623 User Manual Rev F Page 53

Count

The Count element
properties dialog is
shown at right. 

Average width: Defines 
the average character 
width (in pixels). A value 
of 0 means that Win-
dows will use the font's 
default widths.

Name: Allows the count 
description to be 
changed. There can be 
up to two unique counts.

Master Count: The ele-
ment that can be con-
trolled by Change 
Count.

Master: Indicates to the 
sofware that this count 
will be controlling all 
counts throughout the 
particular message and 
will lock out the other count settings during the start of the task.

Start value: Displays the starting value of the counter.

Roll over on: Determines when the counter rolls back to the Start value. (The maximum
number of digits for this field is six.)

Increment by: The number of units added to the current count when a photosensor event is
fired.

Number of digits: Determines the number of significant digits printed. If "Leading zeros" is
checked, the count will be padded with zeros. For the example shown here, 000001 would
be printed.

Orientation: Determines if the data is printed horizontally or vertically. See “Text” on
page 51 for examples of horizontal and vertical text. 
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Pallet Count: For a pallet
count, click the Pallet count
tab and click the Enabled
button. The "Start value",
"Roll over on", and "Incre-
ment by" fields' semantics
are identical to the ones
under the "Box count" tab
(see previous example). 

Units per pallet: The number
of boxes that are loaded
onto one pallet.

The pallet count's Current
count is incremented when
the Units per pallet value is
met. For example, if a pallet
holds 144 boxes, this num-
ber would be entered into
the Units per pallet field.
After 144 boxes have been
printed, the pallet count
would increment.

Rollover: Will reset the Pallet count to the Start value when the Maximum value is reached.
If unchecked, the Maximum value will be as high as the Pallet count will go.

Date / Time Element

The Date / time element properties dialog is
shown at right. 

Avg. font width: Defines the average character
width (in pixels). A value of 0 means that Win-
dows will use the font's default widths.

Format: Determines how the current date or
time is printed. For a list of pre-defined for-
mats, see the Define, Custom Date / Time
Formats section of this manual. 

Build: To build a new format, click the Build
button. For a description of the Build date/time
format dialog, see “Custom Date/Time For-
mats” on page 33.

Orientation: Determines if the data is printed
horizontally or vertically. See “Text” on
page 51 for examples of horizontal and verti-
cal text.
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Expiration

The Expiration date element
properties dialog is shown at
right. 

Avg. font width: Defines the aver-
age character width (in pixels). A
value of 0 means that Windows
will use the font's default widths.

Format: Determines how the cur-
rent date or time is printed. For a
list of pre-defined formats, see
“Custom Date/Time Formats” on
page 33. 

To build a new format, click the
Build button. For a description of
the Build date/time format dialog,
see “Custom Date/Time Formats”
on page 33.

The expiration period is determined by adding the "Days" and "HH:MM:SS" fields to the
current system time.

Round to top of unit: Forces the expiration code that is printed to round up to the next
whole unit.

Orientation: Determines if the data is printed horizontally or vertically. See “Text” on
page 51 for examples of horizontal and vertical text.

Rollover: When "Rollover" is selected, the expiration code rollover time can be changed to
a different value than midnight. See the Rollover section in “Date/Time Codes” on page 35
to enter a new setting.
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User Prompted

The User element properties dialog is
shown at right. 

Avg. font width: Defines the average
character width (in pixels). A value of 0
means that Windows will use the font's
default widths.

Data: Displays the data to be printed. If
"Use default character" is checked, the
data shown in the editor will be drawn
with the "W" character. In this example,
"WWWWWWWWWWWWWWW"
would be displayed in the editor (15
W's, since "Max chars" is set to 15).

Prompt at task start: When checked,
the operator will be prompted by the
Marksman© Matrix & Elite Control
application when the task is started.
The data displayed in this prompt is
determined by the Prompt field.

Orientation: Determines if the data is printed horizontally or vertically. See “Text” on
page 51 for examples of horizontal and vertical text.

Shift Code

The Shift element properties dialog is shown at right. 

A Shift element prints the current shift code. See
“Shift Codes” on page 36 for more information.

 

Avg. font width: Defines the average character width
(in pixels). A value of 0 means that Windows will use
the font's default widths.

Orientation: Determines if the data is printed horizon-
tally or vertically. See “Text” on page 51 for examples
of horizontal and vertical text.
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Barcode

The Barcode element proper-
ties dialog is shown at right. 

Symbology: Displays the type
of barcode to be printed. The
following symbologies are sup-
ported:
• 128
• 39 Standard
• 93
• Datamatrix ECC200
• GS1-DataMatrix
• GS1-128
• GTIN-12 (UPC-A)
• GTIN-13 (EAN-13)
• GTIN-14 (ITF-14)
• GTIN-8 (EAN-8)
• I 2of5
• QR Code
• UPC-E

Magnification: Indicates when set of barcode parameters are used to draw the barcode.
See “Global Barcode Parameters” on page 40 for information on barcode parameters.

Data: Contains the data to be encoded in the barcode.
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Code 128 barcodes support sub-elements and application identifiers. To modify these,
uncheck the "Simple data" box. The following is an example of a Code 128 barcode with
two sub elements: 

See the “Sub-Elements” on page 37 and “Application Identifiers” on page 39 for more infor-
mation.

Move item up 
or down in list

Properties

Insert Application 
Identifier

Insert new 
sub-element
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Database

Click Cancel to return to the
Database element screen.
(This screen is for future
enhancement.)

The Database element 
properties dialog is shown at 
right. 

A Database element looks up a 
piece of data from a given 
database and prints it.

Avg. font width: Defines the 
average character width (in 
pixels). A value of 0 means that 
Windows will use the font's 
default widths.

DSN: Displays the name of the 
selected ODBC database. To 
select a different database, 
click Browse. The user will be 
presented with the "Select 
Data Source" dialog (see next 
page).

Table: Displays the table in the
database to query. 

Field: Displays the field name in the selected table. The value of this field is data that will be
printed. The user may also browse the fields in the current table by clicking Select (see the
Select field dialog on the next page). 

If a given record is to be retrieved by a key value, check the "Use" box under "Key field". In
this example, the record from the Messages table whose ID is equal to 2434 will be
selected. The value of its Name field will be printed. The Key Field may be selected by
clicking the "Select" button (see the "Select field" dialog on the following pages).

Orientation: Determines if the data is printed horizontally or vertically. See “Text” on
page 51 for examples of horizontal and vertical text.
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Following is an example of what the "Select Data Source" dialog might look like: 
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The following is an example of what the "Select field" dialog might look like: 

To insert an SQL statement directly,
click the "General statement" tab. An
example using a general SQL state-
ment is shown at right.

If this option is used, the first field in
the first record of the result set will be
the data selected to print.



 Section 6: BoxWriter© Matrix & Elite EditorMarksman Matrix & Elite

2465-623 User Manual Rev F Page 62

Serial

The Serial element properties dialog is
shown at right. 

A Serial element prints data from the
serial buffer. The serial buffer is defined
in the Controllers Control application.

Avg. font width: Defines the average
character width (in pixels). A value of 0
means that Windows will use the font's
default widths.

Start index: Specifies the index in the
serial buffer to start copying from.

Length: Specifies how many characters
to copy from the serial buffer.

Orientation: Determines if the data is
printed horizontally or vertically. See the
Text Element section for examples of
horizontal and vertical text.

In the Editor, a Serial element will be dis-
played with W's. In this example, it would look
like this: 

Shapes

The Shape element dialog is shown at
right.
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ToolBars

Zoom Custom: This command allows 
the user to set an arbitrary zoom factor 
for the current view. Valid zoom factors 
are in the range of 10% to 200%.

About: This command displays the 
"About" dialog. This dialog lists all the 
major components of the editor and 
their version numbers.

Font bar

The font bar allows the user to
change the font properties of any
selected elements that have a font
(i.e., Text, Count and Date / time
elements). 

New 
Task

Open 
Task

Save 
Current 

Task

Delete
Copy 

Selected 
Element Undo

Cut 
Selected 
Element

Paste

Zoom In

Redo

Zoom Out

Zoom Normal 
(100%)

Zoom 
Custom

Fit to 
Screen

About
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Rotation Bar

The rotation bar allows the user to change the box's orientation, relative to the print heads. 

Sometimes changing the 
box's orientation will result in 
some elements being forced 
outside the printable area. 
When this happens, the Edi-
tor will warn the user. 

If it is acceptable to move the affected elements, click Yes and they will automatically be
repositioned. Otherwise, click No and the box will be returned to its original orientation.

Alignment Bar

The alignment bar allows the user to apply various transformations to the currently
selected elements. 

NOTE: The minimum number of elements that must be selected for Left, Center, Right,
Top, Middle, and Bottom is two (2). The minimum number of elements that must be
selected for Distribute evenly vertically and Distribute evenly horizontally is three (3).

 

Counter-
clockwise

UpDown

Clockwise
Left

Right

Center

Top

Middle

Center 
on Box

Distribute 
Evenly 

Vertically

Distribute 
Evenly

Horizontally

Inverse

Flip
Vertically

Flip
Horizontally

Italic

Bold

Right

Bottom

Left
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Perspective
To change the perspective of the box view,
select View > Change perspective. 

The x and y axis perspectives must be
between -90 and 90 degrees.
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Section 7: Maintenance and Shutdowns

APS - Automatic Priming System

NOTE: The system will not prime either manually or automatically if there is a low ink indi-
cation. Low ink indication is caused by either low ink in the reservoir or full ink in the waste
collection bottle.

The APS is an invaluable tool for routine cleaning of loose debris from the print engine
face. The images below demonstrate print before and after the APS. (See “FJSOP2 - Daily
Maintenance for AMS/APS Printheads” on page 95 for additional information.)

NOTE: The duration of the APS cycle is approximately 5 - 10 seconds.

BEFORE APS

AFTER APS
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System Maintenance

Intermittent (as required):
• Be sure the photosensor is clean and free of debris.
• Be sure the O-rings on the encoder wheel are present and not worn.
• Be sure the nuts and bolts holding the bracketry in place remain tight.

Annually:
• Replace encoder O-rings (5765-206).
• Recalibrate Touch Screen.

General Maintenance:
• Dust touch screen and keyboard with lint-free cloth.
• Clean controller cabinet with cloth to remove dust.
• Inspect print head assemblies and ink reservoir for leaks and wipe with lint-free cloth as

necessary.
• Use the priming procedure to remove any dust or debris that might have collected on

the print head faceplate (see “Step 5: Priming the Print Heads” on page 12).
• Inspect for broken or worn electrical connections.
• Inspect guide box rails and print head bracket for wear.
• Make sure the controller cabinet fan(s) are working and that they turn freely.
• Have a qualified technician open the printer cabinet and inspect for dust. If necessary,

blow out dust with low-pressure air that is moisture- and oil-free.
• Inspect the fan filter and replace if necessary. To replace the fan filter, simply remove

the louver plates on the outside side panels of the Marksman© Elite. The filter is
located under this plate. The fan filter can be cleaned with low-pressure air. For thor-
ough cleaning, clean with soap and water and allow to dry before re-installing.

• With the printer off, make sure tie wraps securely hold all cables. Replace any missing
tie wraps or damaged cables.
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Print Head Maintenance

Daily / Shift Startup / Periodic

Wear safety goggles when working with industrial inks or solutions!

The majority of print quality degradation is due to excessive debris deposits on the
print head orifice plate that disrupt the ink droplet path. For best preventative main-
tenance practices, do the following:

• Pause or stop the message to avoid any misprinting. It’s OK to leave the system pow-
ered up during this time.

• Remove excessive debris build-up (corrugate dust, glue strands, and the like) on and
around the front of the print head by using maintenance spray n-Propanol (5760-695)
on a clean lint-free cloth (6600-171) and wiping the front plate and enclosure. If debris
build-up is noted on the enclosure and rear of the print head, then wipe those clean,
too.

NOTE: DO NOT SPRAY N-PROPANOL MAINTENANCE SPRAY DIRECTLY ON THE
PRINT HEAD OR ANYWHERE NEAR THE ORIFICE PLATE.

• Using a sponge swab (5760-832), rub the orifice
plate lightly from top down in a vertical direction
while ink is flowing during an APS (Automatic Prim-
ing System) cycle. The APS button is located on
the rear of the print head. DO NOT USE mainte-
nance spray directly on the orifice plate.

• Press the APS button one more time to ensure
channel priming, but do not swab this time.

• Wipe the front plate with a clean lint-free cloth to
remove any excess ink.

Annually
• Replace the vent filter on the res-

ervoir.
• Depending on desired quality of

print, print heads may need to be
returned to the factory for a thor-
ough cleaning of the print engine
due to excessive debris lodged in
the orifices

SWAB 
DOWN



 Section 7: Maintenance and ShutdownsMarksman Matrix & Elite

2465-623 User Manual Rev F Page 69

Shutdown Procedures

• Close the Application (double-click the X in the upper right hand corner). 

NOTE: You must have the proper security level before the application will close.

• When Windows® is at the desktop, select Start, then select Turn Off Computer. 
• Select Turn Off Computer (Windows® will perform its shutdown sequence). 
• When Windows® is done, the screen will be all white. 
• It is now safe to turn the power off. 

Shutdowns of 1 Week to 3 Months
• Disconnect the system from mains power.
• Spray the appropriate maintenance spray

on a lint-free cloth and, before installing
ship cap, lightly wipe the front of the print
head to remove foreign debris. 

• Remove the ink bottle, close the reservoir
vent cap and install the reservoir ship cap.

• Install the ship cap onto the front of the
print head.

Shutdowns of 3 Months or More
• Follow recommendations for Shutdowns of 1 Week to 3 Months (above).
• It is recommended that the print head system be flushed with ScanTrue® II Flush Solu-

tion and that ScanTrue® II Flush Solution be left in the print head during the storage
period. (See “Appendix C: Part Numbers” on page 83 for consumable part numbers.)
Follow instructions in document 2465-257N. Flush Solution can remain in the print
head for one year from the date of flushing.

Startup
• Ensure all electrical connections are made and power up the controller.
• Allow the print head to heat up and perform a visual inspection on the heads before

using.
• Open the reservoir vent cap and install a bottle of ink.
• Perform 3 to 5 prime cycles while the Ship Cap is installed.
• Remove the Ship Cap.
• Prime the print head per “Step 5: Priming the Print Heads” on page 12.

THUMBSCREWS

SHIP CAP
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Ink Storage

Storage Life of a FACTORY SEALED Bottle of Ink
• ScanTrue II: 12 months from date of manufacture.
• ScanTrue II Plus: 18 months from date of manufacture.
• Recommended storage temperature: 4° to 40°C (40° to 104°F).
• Recommended storage relative humidity: 5 - 90% relative humidity with no condensa-

tion.

Temperatures above or below the recommended storage temperature for a period greater
than one week will reduce the storage life of the ink.

NOTE: Do not shake the bottle of ink before use. Agitating the ink may introduce air into
the Print Head. If shaken, the bottle must sit for at least two hours before use.

Use Life of an OPENED Bottle of Ink
• ScanTrue II: 3 months from opening.
• ScanTrue II Plus: 6 months from opening.

Exposure to air, temperature and relative humidity will affect the useful life of the ink.
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Section 8: Troubleshooting

The Marksman© Matrix & Elite ink jet system incorporates advanced designs, both in hard-
ware and in software. However, if the system ever fails to perform properly, some built-in
indicators will help in troubleshooting. This section will help minimize system downtime and
explain some of the diagnostic features built into the system.

Troubleshooting Notes
Most controller problems will be the result of improperly connected cables. Check all con-
nections, including power interface, print heads, encoder, and photosensor. (See Appendix
B, Theory of Operation for details.)

Problem: Cannot communicate to the Marksman© Matrix or Elite through the Ether-
net. 

Action: 
• Power down, then power up the computer and the Controller.
• Check for proper Ethernet cabling.
• Verify that the IP addresses are valid for the computer and the Controller.

Problem: The system does not print.

Action:
• Check that there are no errors on the head.
• Check that the encoder is active.
• Check that the photosensor is enabled, sensing a product.
• Check that the configuration is correct for the head being used.
• Check that a valid label is selected.

Problem: No Shaft Encoder.

Action:
• Make sure that the encoder wheel is contacting the conveyor.
• Make sure that the encoder is connected and plugged into the proper port.
• Check the configuration for proper setup.
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Troubleshooting Tests

Print Test

This test will determine if the print heads are printing.
1. Place a cloth in front of the print head front plate.
2. Initiate a print cycle by turning on conveyor and tripping the photosensor.
3. Check for ink on cloth.

Printed dots on cloth indicate that the system is printing. Check product sensor offset set-
tings, product length, or product margins if print is not seen on carton.

No ink on cloth indicates that the system is not printing. Review system status to determine
other possible causes of system not printing, including a test of the photosensor and
encoder to ensure operation.

Photosensor Sensitivity Test

This test will determine if the photosensor sensitivity is adjusted correctly for the applica-
tion.

NOTE: The test object should be a sample of the actual product. 

1. Place the test object approximately ¼ inch in front of photosensor; photosensor should
sense object.

2. Place the test object near the center of the guide rails; photosensor should sense
object.

3. Place the test object on far guide rail; photosensor should not sense object. 
4. Check that objects on the far side of the conveyor do not trip the photosensor.
5. Check that color differences in product do not cause multiple photosensor trips at the

farthest sensing distance. 

NOTE: If the red LED on the photosensor fails to illuminate when an object is placed in
front of (but not touching) it, this is an indication that the photosensor is disconnected, or
the power supply or photosensor has failed. 
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Print Quality Troubleshooting
This section shows examples of various print problems and actions which should be taken
to improve the print.

Problem: Minor fractures in print channels.

Possible Cause: Debris on front plate, air in channel.

Action: Run APS. Add brushes and positive air flow to minimize debris build-up.

Problem: Missing channels and channel fractures in print channels.
Possible Cause: Excessive debris on front plate, air in channel.
Action: Wipe front plate and run APS. Add brushes and positive air flow to minimize debris
build-up.

Problem: Missing print channels.
Possible Cause: Air in channel.
Action: Run APS. If air cannot be removed, follow procedure for “Recirculation” on
page 12.
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Problem: Missing bottom print channels.
Possible Cause: Ink build-up on lower orifices.
Action: Wipe front plate and run APS.

Problem: Fuzzy print.
Possible Cause: Print head too far away from substrate.
Action: Move print head to within 1/8" from product.

Problem: Occasional checkerboard print pattern.
Possible Cause: Encoder slipping or bouncing on belt.
Action: Tighten encoder on belt; replace encoder o-rings, if required; or replace conveyor
belt with a smooth seamless belt.
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Problem: Stretched out, light print, checkerboard pattern.
Possible Cause: Incorrect encoder, or incorrect line speed (set too low) if using internal
encoder.
Action: Check for correct encoder (use 5000 PPR Encoder).

Problem: Short image, dark print, checkerboard pattern.
Possible Cause: Incorrect encoder or wheel size, or incorrect line speed (set too high) if
using internal encoder.
Action: Check for correct encoder (use 5000 PPR Encoder).
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Appendix A: Specifications

Matrix Controller Specifications 

Processor: Intel® Celeron™ N2930, 1.83GHz, Quad-Core
Ports: 2 Com Ports (Serial Ports)

1 VGA
1 Beacon
2 Print head with room for additional 2 Print head ports
2 Encoder with room for additional 2Encoder ports
1 RJ-45 Gigabit LAN
1 Audio (Not Supported)

Memory: 2 GB, 204pin DDR3L SO-DIMM
Data Storage: 128 GB Solid State SATA drive
Alarm: Optional 3 color LED beacon
Enclosure: Stainless Steel
Weight: 8.13lb. (Controller only)
Operation System: Windows® Embedded Standard 7, 32 Bit
Display: 10.2 inch 1024 x 600 LCD with Resistive touch screen.
Keypad Software
Electrical: 90-240 VAC, 50/60Hz, 2.0A max. (power supply input)

2 each 24 VDC, 5.0A (Controller input)
Environment: Ambient operating temperature: 40° to 104° F (5° to 40° C)

Operating humidity: 10-90%, non-condensing
Print head types: ProSeries 768e and ProSeries 384e
Operation humidity: 10% - 90%, non-condensing

8.00
[203.2]

14.75 [374.7]

4.04
[102.5]

5.00
 [127.0]

1.33 [33.7]

5.63 [142.9] 3.50 [88.9]

REAR
M6 x 1

FRONT

BOTTOM
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Matrix Wiring Diagram

J2 J1J2 J1

PHC BOARD 2
JUMPER SETTINGS

ON

2465-630

2465-331

2465-323

2465-621

2465-629

2465-612

2465-615

2465-616
2465-628

DISPLAY DRIVER
BOARD

DISPLAY BRACKET AND DISPLAY

STROBE

FAN

POWER

VGA

COM 2

PHC BOARD 2PHC BOARD 1

Black/Blue
Black/Green

2465-328

RED WIRE
THIS END

OFF

SW SETTINGS

HARD DRIVE

CPU JUMPER SETTINGS
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Elite Controller Specifications 

Processor: Intel® Celeron™ N2930, 1.83GHz, Quad-Core
Power Input: 100-240VAC, 50-60Hz at 3A max
Ports: COM1, COM2 Serial Ports RS232

10/100/1000 Mbit/sec Base-T Ethernet
2 or 4 Print Head ports
2 or 4 Encoder ports
Beacon, 3 color
VGA 
2.0 USB ports,1 external and 3 internal
HDMI
Audio

Memory: 2 GB, 204pin DDR3L SO-DIMM
Data Storage: 128 GB Solid State SATA drive
Alarm: Optional 3 color beacon
Enclosure: Stainless Steel
Weight: 26.5 lbs (12.0 kg) (Controller only)
Operation System: Windows® Embedded Standard 7
Display: 17” diagonal 1280x1024 LCD with Resistive touch screen.
Keypad Software
Environment: Ambient operating temperature: 40° to 104° F (5° to 40° C)

Operating humidity: 10-90%, non-condensing
Print head types: ProSeries 768e and ProSeries 384e

Print head to controller:25 ft (7.6 meters) max.

13.75 [349.3mm] 5.75 [146.1mm]

17.75 [450.9mm]

5.000 [127.0mm]

5.00 [127.0mm]

4.38 [111.1mm]3.500 [88.9mm]

BLIND FASTNER
(PEM BS-M6-1)
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Elite Wiring Diagram
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Print Head Specifications

384e Print Head: 

768e Print Head: 

1.01in
[25.6mm]

14.31in
[363.5mm]

5.00in
[127.0mm]

2.75in [69.9mm]

3.02in
[76.7mm]

5.50in [139.7mm]

12.60in [320.1mm]

21.32in [541.5mm]

11.70in [297.1mm]

3.00in [76.2mm]

2X #10-32 X .25 DEEP
(BOTH SIDES)

2X #10-32 X .25 DEEP
(BOTH SIDES)

21.77in [552.9mm]

3.00in [76.2mm]

13.05in [331.5mm]

11.70in [297.1mm] 2.80in [71.1mm]

6.32in
[160.5mm]

14.31in
[363.5mm]

5.50 [139.7]

3.02in
[76.7mm]

1.07in
[27.2mm]
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Electrical Connections: Male DB-25 connector located on the rear of the print head.

Print Orientation: Integrated - Horizontal or horizontal angle (for incline printing)

Ink System: Non-pressurized capillary feed technology

Priming: Automatic Priming System (not included with Alpha-

Coder Print Heads)

Float switch sensor: Low ink and full waste bottle detection

(waste detection not included with AlphaCoder Print Heads)

Ink Specifications: ScanTrue® II PLUS (384e and 768e Print Heads), Pigmented

oil-based for porous surfaces

Technical Data: 

Operating Conditions: Temperature: 50° - 104° F (10° - 40° C)

Relative Humidity: 20 - 80% (non-condensing)

Storage Conditions: Temperature: 32° - 109°F (0° - 43° C)

Relative Humidity: 20 - 80% (non-condensing)

384e Head 768e Head

Image Area: .38" - 2" (10 - 51mm) .38" - 4" (10 - 102mm)

Channels: 128 256

Orifices: 384 768

Horizontal Resolu-
tion:

150 or
300 dpi

150 or
300 dpi

Lines of Print: 1 - 21 1 - 42



 Appendix B: Theory of OperationMarksman Matrix & Elite

2465-623 User Manual Rev F Page 82

Appendix B: Theory of Operation

The Marksman© Matrix & Elite 
The Marksman Elite and Matrix are high-resolution ink jet coders used to print fixed and/or
variable information onto cartons as they pass in front of the print heads on a conveyor.
The Marksman Elite and Matrix are industrial PC-Based controllers that use a single board
computer (SBC) running Windows Embedded Systems 7 to process and generate the
images to be printed. Included on the SBC are all the peripherals associated with the com-
puter, such as the video controller, Ethernet controller and USB controllers. In addition to
the SBC, there are USB print head controller boards (USBPHC).   The USBPHC board is
responsible for converting an image from the SBC to image data that the print head can
print. The USBPHC board uses a USB port to relay head status information from the head
to the SBC. The USBPHC board sends and receives data to the head through the print
head cable (DB25) as needed. 

Messages are entered using the touch screen display with software keyboard. All message
and programs are stored on a solid state hard drive and is recalled as needed when a mes-
sage is selected. For the Elite, power for the system is create from two different power sup-
plies, 12V needed for the SBC and display and 24V for print head heaters and the DC-DC
converter. The Matrix only requires an external 24V power supply. The 12V is generated
internally from the 24V supply.

Print Heads
The Marksman© Matrix & Elite supports all the Marksman series printheads. A typical prin-
thead includes a reservoir section, drive electronics, and a print engine.   The information
and power needed for printing are sent to the print head through the DB25. 

The drive electronics include a Universal Driver Board and Marksman© Driver Board. The
Universal Board takes 24VDC and generates the high voltage needed by the print engine. 

The APS includes an ink collection bottle, vacuum pump, APS board, purge pump and res-
ervoir. The APS cycle is controlled by the Controller via a DB9 cable. Parameters are set
through the software. It is important for the cable to be connected. The power and low ink
signals are sent to the Controller through the DB25 cable.   The ink collection bottle stores
the used ink from the APS cycles. If the bottle becomes full, or the reservoir is low, the APS
is disabled and the red LED on top of the Ink Supply will turn on.

Photosensor
The photosensor detects a product as it passes in front of the sensor. The signal starts the
printing process. Once the printing process has started it will continue until the label is com-
plete, regardless of what the photosensor signal does.

 

Encoder
The encoder is used to signal the controller when to print another column of ink. There are
two encoder options, external or internal. The external encoder rides on the conveyor to
determine how often to print a column of ink. As the conveyor's speed changes, so will the
period of time between the printing of the columns of ink. The internal encoder is timed-
based so that if the speed of the conveyor changes the print will be stretched or com-
pressed until the encoder speed is corrected.
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Appendix C: Part Numbers

System
Part No. Description

Print Head

2464076 ProSeries 384e

2464076F ProSeries 384e, Flushed

2464078 ProSeries 384e, 90 Degree

2464078F ProSeries 384e, 90 Degree, Flushed

2464079 ProSeries 384e, Modular

2464079F ProSeries 384e, Modular, Flushed

2464082 ProSeries 768e

2464082F ProSeries 768e, Flushed

2464083 ProSeries, 768e. Modular

2464083F ProSeries 768e, Modular, Flushed

2464084 ProSeries 768e, 90 Degree

2464084F ProSeries 768e, 90 Degree, Flushed

Controller

2465006D2 Marksman© Matrix, 2 Head, Domestic

2465006E2 Marksman© Matrix, 2 Head, European

2465006D4 Marksman© Matrix, 4 Head, Domestic

2465006E4 Marksman© Matrix, 4 Head, European

2465004D2 Marksman© Elite, 2 Head, Domestic

2465004E2 Marksman© Elite, 2 Head, European

Print Head/Controller Bracketry

2464550 Print Head Conveyor Mount Bracket

2464561 X-Y Axis Linear Adjustment, Tool-LessBracket

2464562 Conveyor Mount/Roller Bracket for 768 Print Head

2464563 Print Head Floor Mount Bracket Kit

2464564 Conveyor Mount/Roller Bracket for 384 Print Head

2465243 Kit, T-Stand, Matrix & Elite

2465244 Kit, Conveyor Mounting, Matrix & Elite

2465254 Kit, Pivot Bracket, Matrix & Elite

Encoder, Photosensor, Alarm Beacon

5700820-IJ Encoder, 300 DPI

2465224 Photosensor, ProSeries

2465253 Alarm Beacon (Strobe), 3-Color

2466525 Photosensor, Auxiliary, APS Controller

Cabling

2464182-010 Cable, Straight Thru, DB9, 10 Ft.

2464182-025 Cable, Straight Thru, DB9, 25 Ft.

2464182-050 Cable, Straight Thru, DB9, 50 Ft.

2464155-002 Cable Kit, Print Head, DB25, 2 Ft.

2465155-010 Cable Kit, Print Head, DB25, 10 Ft.

2465155-025 Cable Kit, Print Head, DB25, 25 Ft.

2464312 Cable, APS Photocell Network ("Y" Cable for sharing Auxiliary Photocell)
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Consumables 

Matrix Spare Parts Kits

Elite Spare Parts Kits

Accessories

Part Number Description
001-0598-01F Ink, ScanTrue® II PLUS
001-0899-01 Flush/Storage Solution, ScanTrue® II

2464620 Kit, Ink Waste Bottle, ScanTrue® II (4/pack)
5760373 Filter, 74 Micron (5/pack)
2464649 Kit, Filter Upgrade/Replacement
6000171 Print Head Wiping Cloth (300/pack)

Part Number Description
2465266 Kit, Display
2465246 Kit, Print Head Controller Board, upgrade/replacement
2465268 Kit, 24V to 12V, Board
2465278 Kit, CPU Board and Hard Drive, Matrix
5760333 Kit, Power Supply, 24V

Part Number Description
2465245 Kit, Display
2465246 Kit, Print Head Controller Board, upgrade/replacement
2465260 Kit, CPU Board, Windows 7
2465277 Kit, CPU Board and Hard Drive, Elite
2465249 Kit, Power Supply, 12V
2465250 Kit, Power Supply, 24V
2465251 Kit, Fan, Elite

Part Number Description
2465253 Kit, Beacon, Matrix & Elite
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384e and 768e Print System Service Kit

ITEM NO. PART NO. DESCRIPTION
1 2464650 Print Engine Replacement Kit, 384e, with Tubing and Fittings

2464651 Print Engine Replacement Kit, 768e, with Tubing and Fittings
2 2464614 Prime Pump Replacement Kit

3 & 8 2464616 Reservoir & Ink Line Tubing Replacement Kit, ScanTrue® II PLUS
4 2464617 APS PCB Replacement Kit
5 2464618 Ink Separator Replacement Kit
6 2464620 Ink Waste Bottle Kit, ScanTrue® II PLUS Ink (4/pack)
7 2464649 Vent Filter Replacement Kit
9 2464414 Cable, DB-25 Connector to HV Board

10 2464144 Cable, Driver Board to APS PCB
11 5760527 Cable, Reservoir to APS PCB
12 2464146 Cable, Prime Pump to APS PCB
13 2464147 Cable, Vacuum Pump to APS PCB
14 2464629 HV PCB Replacement Kit, 384e and 768e Heads

21

37

8

6

5

4

9

10

14

11

1312
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Appendix D: Database Start

Description
Prior versions of BoxWriter allowed for the start of a task with database elements, which
can then prompt the user to enter the key field value for the Controller to search the data-
base and replace the default database element data with the data from the customer’s
database. In addition to those features, this version allows the Matrix & Elite to prompt for
the key field value, obtain that value, look up that value in the database (which is pre con-
figured for all messages in the Matrix & Elite), find the task field in the database, use that
value to start the corresponding task, and while starting the task, use the previously
entered key field value as the value for all fields in the database. Thus, the user needs only
to enter one value to start the correct task and all data in the task. This is referred to as
Database Start. 

Database Start Task Routine Flowchart
1. If configured, the 

operator initiates a 
database task start 
routine. This can be 
accomplished by 
using the Start play 
button on the tool-
bar. Instead of see-
ing the "Start 
Message" screen, a 
new "Start Task" 
screen will open.

If the Other button is 
used, the Database 
Task Start option is 
bypassed and the normal "Start Message" screen appears. Standard or Database mes-
sages can be started as normal.

2. The system will respond by prompting the user for a key field value.
3. Based on the user's input, the software goes to the predefined record source to locate

the key field based on the value from step #2.
4. Once located, the software pulls up that record's information. Based on the predefined

field for a task name, the system looks at that field for the task name to start.
5. The software then starts that task and any database elements that are tied to the same

record (as in step #4); the system does not prompt the user, but instead uses the data
out of that record automatically. The system is now ready to print, unless there are
additional user-prompted fields necessary (see step #6).

6. If any other user-prompted information is necessary (such as database elements that
specify a different record set or standard user-prompted elements), the system will
prompt for these elements.

7. A new serial option called Database Task Start is available for use with hand scanners
and/or remote systems.
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Database Lookup Definition - Global Setting
In order for the Marksman Matrix or Elite to go to a customer’s database for task name
information, it is necessary to first globally define where that location will reside. Prior to the
Database Start setup, an ODBC connection to the customer’s database must be made with
a unique Data Source Name (DSN). To instruct the Controller where this data will reside,
the details must be entered on the new menu option Configure, Database start.

First, click the Select button to select the DSN entry to use when utilizing the database
start routine.

Each of the available tables (or sheets) will be available based on the DSN entry. Select the
appropriate table for use.

Next, choose the field that will be utilized for the Key field - to identify the record in which
the task name will be found.

Finally, choose the field where the task name is located.

A sample table is shown below for reference (based on input above).

ACE Pizza Sample spread sheet This example is an Excel spread Sheet with a DNS
named ACE PIZZA
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Database Start Task

Press the Start play button on the toolbar.

The operator can either input
the key field data and press
toe OK button, or use the
Select... button to choose
from the database view.

In the database Select Field
screen, scroll down the Key
Field column to the desired
data, and press OK. This will
return you to the Start task.
Press OK to start the process.

Serial Port Modification
In addition to accessing the new menu
option and toolbar button, the serial port
options have been modified to allow for a
"Database task start" as seen in the figure at
right.

When set to the database task start setting,
the system will accept serial input from the
communication port and use this information
as the key field value, as indicated in the
Start task screen in the previous figure.
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Printer Report Modification

In order to determine what key field has been selected by the operator, the printer report
has been modified to indicate the chosen key field. The key field will be indicated on the
preceding line under the Task Name field.
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Appendix E: Hand Scanner

Scan and Shoot Setup
The first step in setting up the hand scanner is determining which numbers in the barcode
are to be used to select the task to be started. The following example will demonstrate the
process by using 5 digits of a 12 digit UPC barcode. You will need to print this page if you
plan on using the example barcode. It may be preferable to get an actual barcode that will
be used.   

Create a task

The task that is to be printed after the
barcode is scanned must be associated
with that barcode. This is done by creat-
ing a task and giving it the name of the
5 digits of the barcode being used to
start the task. In the example below, the
barcode being scanned is: 

0 79068 17001 7

The part of the barcode that will be
used to identify the task is highlighted:
17001. This is the name that will be
given to the task. A task should now be
created using the name 17001.

Scanner
Plug the scanner into a serial port, either the *Auxiliary Input port or Com1 port.

Setup the port that was chosen to match 
the scanner:

Com1:
Configure/System/General Settings/
Com1/Properties

* NOTE: There is +12V on pin 1 of the
auxiliary input port that is used to
power the Foxjet scanner.

Set up the serial port to match the
scanner:
• Baud = 9600
• Party = NONE
• Data Bits = 8
• Stop Bits = 1
• Device Type = Task start
• Line usage = N/A

The port is now set up to start a task from
a serial string.
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Mask task name from a serial string:

To create the mask to separate
the task name from the barcode,
go to the line properties: Config-
ure/Production Line.  Edit the
line where the head is located. 

Buffer offset:  The number of
characters in the string to the start
of the task name, starting with 0.
In our example the offset is 6. 

Barcode characters: 0 7 9 0 6 8 1 

Buffer Offset Count: 0 1 3 2 4 5 6.

Data length: The number of char-
acters in the task name. 

17001= 5 characters

Testing the Start Task

The controller should now be set up to start a task using a hand scanner. Make sure there
are no tasks running; use the Stop button if a task is selected.

Use the hand scanner and scan the barcode that the task was created from. If the task
starts, then the controller is set up. Additional tasks can now be added as needed using the
same approach as above.

If the task fails to start:
• Check that the scanner is programmed for a UPC and that it has a carriage return for a

post amble.
• Check that the scanner is connected to the proper port and that it is configured cor-

rectly.
• If a "Task Failed To Start" message appears, make sure that the task is properly named

and that it matches the barcode.

The Diagnostic window (View\Diagnostic Dialog) can be used to assist in the trouble-
shooting process.
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Appendix F: Communicating Directly to the Controller
Refer to the Ethernet Protocol document 2465653N when communicating directly to the
controller.

Appendix G: Using Serial.cgi Commands through the Serial 
Port

Refer to the Marksman Duo Serial Commands document 2465654N.

Appendix H: Using Marksman Net Software to Communicate 
to the Matrix

Refer to the Marksman Net/Marksman Next manual 2464308.

Appendix I: Using the Marksman Net Protocol to Control the 
Matrix

Refer to the Marksman Net Commands document 2465655N.

Appendix J Using the Print Monitor Software
Refer to the Print Monitor Software document 2465656N.
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Appendix K: Standard Operating Procedures

FJSOP1 - Removal of FoxJet High Resolution Printheads
PURPOSE: To detail the procedure for removing a Foxjet High-Resolution inkjet

printhead from a production line.

RESPONSIBILITY: Customer or authorized FoxJet Distributor technician.

SAFETY: All personnel performing this procedure must wear proper eye pro-
tection and latex gloves.

FREQUENCY: Each time a printhead is to be removed from a production line.

PROCEDURE:

1. Initiate the proper controller shutdown procedure, TURN OFF AND UNPLUG THE
CONTROLLER from electrical power source to avoid possible electrical problems and/
or electric shock.

2. Disconnect all printhead cables from the
controller.

3. Remove the ink bottle and install the Res-
ervoir Ship Cap. 

4. Remove vent cap filter (if applicable) and
close the vent cap.

5. For an AMS/APS system, remove Waste
Ink Bottle and reinstall the Short Black
Protective Shipping Bottle. 

6. Install the faceplate cover on the front of
the printhead (when properly installed it
should cover the CP/OP). 

7. Insure that all printhead covers are prop-
erly installed, clean and all screws are in
place.

VENT CAPRESERVOIR 
SHIP CAP

SHIPPING 
BOTTLE

FACEPLATE 
COVER
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8. Remove all photosensors and photosensor brackets from the printhead, if applicable.

9. Remove screws that hold the printhead to the bracketry.

10. Wrap a clean shop cloth around the front of the printhead to catch any ink that may leak
out and secure the cloth with masking or packing tape.

11. Place a plastic bag over the printhead assembly and secure it with tape. 

12. If the printhead is to be stored for later use, it should be stored in a cool, dry location.

13. If the printhead is to be shipped, it should be well padded and packed in its original
shipping box. 

CAUTION:

Observance and practice of this procedure is critical to insure no damage occurs during
shipping. 

FoxJet will replace, and charge for, any items found to be missing before it can be returned.

FoxJet may deny warranty coverage if the printer or part has failed as a result of abuse, ne-
glect, improper maintenance, improper shipping, or unapproved modification(s). Please re-
fer to the Master Warranty Statement.

END

!
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FJSOP2 - Daily Maintenance for AMS/APS Printheads
SCOPE: All AMS/APS (Automatic Priming System) Printheads.

PURPOSE: Detail the procedure for performing the required maintenance

routine for Foxjet AMS/APS High-Resolution inkjet printheads.

RESPONSIBILITY: Customer.

SAFETY: All personnel performing this procedure must wear proper eye pro-

tection and latex gloves.

FREQUENCY: This procedure is to be performed daily, or as often as required,

depending on print quality.

PROCEDURE:

1. Using a lint-free cloth, carefully clean any corrugated dust, hot melt glue strings and/or
other debris from the faceplate area. Be sure to wipe down the faceplate in one direc-
tion, NOT UP AND DOWN OR BACK AND FORTH, to lessen the likelihood of debris
being pushed into the center slot that protects the CP/OP (nozzles). Failure to wipe in
the appropriate direction may cause blockage in the CP/OP.

2. Press and release the Purge button to initiate an automatic prime/purge cycle (observe
that the ink is vacuumed off the CP/OP).

3. If necessary, wipe excess ink from the bottom of the faceplate with a lint-free cloth. If
ink continues to drip onto the faceplate when the Purge button is used, contact your
FoxJet Service Representative.

4. Verify that all screws are in place and that covers are clean and properly installed.

5. Insure that the front of the printhead is parallel to, and within 6mm (0.25") or less, of the
side of the carton as it passes in front of the printhead.

6. Insure that the conveyor guides are adjusted to prevent cartons from contacting the
printhead.

7. Run a print sample to ensure all the channels are printing and producing good print
quality. 

IF PRINT QUALITY IS ACCEPTABLE, PROCEED NO FURTHER.

8. Press and hold the Purge button for five seconds to prime the system or purge air from
the printhead.
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9. Spray the proper maintenance fluid, as identified below, onto a 5760832 Lint-Free
Swab.

9.1 For Printheads using VersaPrint ink, use FoxJet P/N 9001-0183-01 spray.

9.2 For Printheads using ScanTrue® II PLUS ink, use FoxJet P/N 5760695 spray.

10. Wipe the CP/OP with the dampened swab in a downward direction.

11. Press and release the Purge button to initiate an automatic prime/purge cycle (observe
that the ink is vacuumed off the CP/OP).

12. Run a print sample to ensure all the channels are printing and producing good print
quality. 

IF PRINT QUALITY IS ACCEPTABLE, PROCEED NO FURTHER.

13. If there are any channels that still do not print, repeat steps 8 through 12 as required.

Replacing APS waste ink bottles

FoxJet APS systems have waste ink catch bottles installed to the rear of the printhead/ink
system and employ a waste ink detection circuit to disengage the APS feature when the bot-
tle becomes full. Failure to replace a full waste ink bottle will disengage the APS system.

To maximize equipment longevity and increase performance, preventive maintenance rou-
tines must be performed on pre-defined daily, weekly, and/or monthly schedules.

If performing these measures is not already a regular practice, it should be immediately es-
tablished as a top priority to prolong the life of the system.

FoxJet may deny warranty coverage if the printer or part has failed as a result of abuse, ne-
glect, improper maintenance, or unapproved modification(s). Please refer to the Master
Warranty Statement.

END
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FJSOP4 - Installation of FoxJet High Resolution AMS/
APS Printheads

PURPOSE: Detail the procedure for installing a FoxJet AMS/APS high-resolution
inkjet printhead onto the production line.

RESPONSIBILITY:  Customer or Distributor.

SAFETY: All personnel performing this procedure must wear proper eye pro-
tection and latex gloves.

FREQUENCY: Every time a printhead is installed on the production line.

PROCEDURE: 
1. Remove packing materials and retain for possible future use.

2. Insure that all printhead covers are properly installed, clean and all screws are in place
and tight. 

3. Position the printhead and install the screws that hold the printhead to the printhead
bracketry.

4. Adjust bracketry so that the front of the printhead is parallel to, and no more than 6mm
(0.25”) away from, the side of the carton as it passes in front of the printhead.

5. Insure that conveyor guides are adjusted so that the cartons CANNOT hit the print-
head.

6. Remove the Reservoir ship cap and install the ink bottle (insure the expiration date on
the ink bottle has not yet occurred).

7. Open the vent cap and install a clean vent cap filter (FoxJet PN 5765210).

8. Remove and the save the APS bottle labeled "For Shipping Purposes Only", and install
an ink waste bottle (FoxJet PN 2464620).

9. Remove the faceplate cover from the front of the printhead (Save the faceplate cover
and Reservoir ship cap for use when you remove the printhead from the production
line).

10. Switch controller power OFF. 

11. Unplug controller from power source, if applicable.

12. Connect the printhead cable to the controller. 

13. Connect the photosensor cable to the printhead, if applicable.

14. Plug the system into a dedicated source of clean electric power.

15. Turn the power on to the printhead and wait for it to heat to temperature, which should
take approximately five to ten minutes.
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16. Using a lint-free cloth, wipe in a downward direction, to remove any excess ink that may
have dripped onto the faceplate. DO NOT WIPE IN THE CENTER SLOT THAT PRO-
TECTS THE CO/OP (nozzles).

17. Press the Purge button for five seconds to purge any air out of the system.

18. Observe the CP/OP while pressing the Purge button (see previous step). If any air bub-
bles or foam emit from the CP/OP, repeat Step 17. Repeat this step until no bubbles are
present in the ink flow. If there are still bubbles after ten attempts, contact your FoxJet
Service Representative.

19. Run a print sample to ensure all the channels are printing and producing good print
quality. 

IF PRINT QUALITY IS ACCEPTABLE, PROCEED NO FURTHER.

20. If there are voids (horizontal lines) in the print, allow the Printhead to heat for four
hours. If the Printhead is new or has been closed for several weeks, it could take four to
twelve hours of heating to recover all of the print lines. During this time, APS cycles will
accrue to help the process. If, after a day of heating, the print is not acceptable or more
air bubbles show up, contact your FoxJet Service Representative.

END
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